
Overview of JAWS Remote Access  

Remote access software, like Citrix Program Neighborhood and Remote Desktop 
Connection, allows you to establish a connection from your computer (called 
the client ) to another computer (called the server ). Once connected, you can run 
programs and view files just as if you were sitting at the server s 
keyboard. The server handles all processing and data storage tasks. The client 
computer acts as an intermediary between you and the server, relaying your 
commands and displaying the results.  

Visually, users see a graphical representation of the server s desktop on their client 
computer. However, the version of JAWS installed on the client cannot 
read or interact with this image. With JAWS remote access, you install a version of 
JAWS on the server to provide speech and braille access to programs 
you use while in a terminal session. The version of JAWS installed on the server 
sends the output to the client through a virtual channel. The version 
of JAWS installed on the client computer then relays this output to the user through a 
synthesizer and/or braille display.  

The Remote Access feature is only available for licenses of JAWS Professional that 
use Internet License Manager (ILM) for authorization. You cannot use 
the Quella or thumb drive versions of JAWS in terminal sessions.  
The Remote Access feature must be purchased separately.     

Remote Access System Requirements

  

Server System Requirements 
Citrix and Terminal Services both allow client computers to connect to the server and 
access programs and files stored on it through the Windows user interface. 
Your server must meet the following requirements:   

Microsoft Windows 2000/XP or Windows Server 2000/2003.   
If you are using Citrix ICA protocol, you will need Citrix MetaFrame Feature Release 

3 or later.   

Client System Requirements 
Client computers can use Remote Desktop Protocol (RDP) or Citrix Independent 
Computer Architecture (ICA) protocol to connect to a server and access its 
programs and files. JAWS only supports Windows-based clients.   

There are no additional system requirements beyond those required for JAWS and 
Citrix Program Neighborhood, Terminal Services Client, and/or Remote Desktop 
Connection. For more information, see JAWS System Requirements. 
In addition, client computers must meet the following minimum requirements:    

Program Neighborhood Client version 7.0 or later, if you are using Citrix ICA 
protocol.  



 
If you are using Terminal Services, you need either Microsoft Remote Desktop 

Connection version 5.0 or later or Terminal Services Client version 5.0 or later.   
One or more serial ports, if you are using a serial hardware synthesizer or braille 

display. One port is required for each device.   
One or more USB ports, if you are using a USB hardware synthesizer or braille 

display. One port is required for each device.   

User and Shared Profiles for Remote Access

  

Just as Windows provides a My Documents folder for each user on a computer or 
server, JAWS allows each user to have their own profile. This profile contains 
the user's custom configuration files, dictionary files, scripts, graphics files, schemes, 
voice settings, and other settings. This allows different users 
on the same system to set up and run JAWS in completely different ways. JAWS 
saves your user settings in Documents and Settings\User Name\Application 
Data\Freedom Scientific\JAWS\Settings\Enu.  

In addition to these user profiles, JAWS also sets up a shared profile. JAWS uses the 
settings in this shared profile whenever the user has not specifically 
defined their own custom settings. The shared profile allows a network administrator 
to set up a baseline configuration for JAWS according to the needs 
of that network's users. JAWS saves shared settings in Documents and Settings\All 
Users\Application Data\Freedom Scientific\JAWS\Settings\Enu.  

Note: User settings override any identical setting specified in the shared profile.  

User and shared profiles allow JAWS to work better with Citrix MetaFrame and 
Terminal Services. Each user that connects remotely to the server uses his 
or her own user settings, without overriding the shared settings or the settings of 
other users. Your settings for remote sessions are stored on the server 
and are available if you connect to the server using the same account and a different 
client computer. A user can have different settings for using JAWS 
locally on the client computer and using JAWS remotely with the server.  

Assigning Access Privileges

  

Before installing JAWS on the server, ensure that you have full write access to the 
folder where JAWS will be located. All JAWS users should have read-only 
access to this folder using the same network name.  

JAWS saves user settings files in the folder Documents and Settings\User 
Name\Application Data\Freedom Scientific\JAWS\Settings\Enu (where User Name is 
the name associated with the user account). Users must have read and write access 
to these files.  

Settings in shared files apply to all JAWS users on the computer or network. JAWS 
saves shared files in Documents and Settings\All Users\Application Data\Freedom 
Scientific\JAWS\Settings\Enu so they are accessible to each user that logs on to the 
computer. Users must have a minimum of read-only access to these files.  



Remote Access Installation Instructions

  
You must install JAWS on the server and all client computers. The server and/or 
client must have the proper licenses with the remote access option enabled 
(see  Authorizing JAWS for Remote Access). In addition, JAWS 6.20 or later must be 
installed on the server computer.   

Installing JAWS on the Server  

There are several different ways you can install JAWS on the server. If users need 
speech and/or Braille access when using the server computer locally, see Installing 
with Speech. This procedure installs the JAWS video driver in the display chain and 
requires you to restart the server. If local users of the server computer do not 
need speech and/or Braille access, see  Installing without Speech. This procedure 
allows you to install JAWS without inserting the video drivers in the display chain or 
restarting the server. In addition, if no local users of the server need to use JAWS, 
you can install the program from a remote computer. For more information, see  
Installing Remotely.  

Note: You must have administrative privileges for the server to install JAWS.   

Installing with Speech  

Do the following to install JAWS with remote access support on the server. This 
procedure provides JAWS speech and Braille access for local users of the 
server. You must restart the server after installation.  

1. Insert the JAWS program CD into the server s CD drive.  
2. When the JAWS Setup dialog box displays, choose the JAWS for Windows Setup 
button. If the dialog box does not appear, press WINDOWS Key+R,  
type D:\Setup.exe

 

and press ENTER (if your CD drive is not D, substitute the correct letter).   

Note: If you are installing JAWS from the package for the Web, press WINDOWS 
Key+E, navigate to the folder where you saved the package file, select the 
file, and press ENTER.  

3. When Setup asks you to select an installation type, select Custom.  
4. Press DOWN ARROW twice to select "Client."  
5. Press the SPACEBAR and then press DOWN ARROW to select "Entire feature 
will be installed on local hard drive." Press ENTER.  
6. Follow the instructions and complete the installation. For more information on 
these options, see  
JAWS for Windows Setup.   

Installing without Speech  

Do the following if no local users need to use JAWS on the server. This procedure 
allows you to install remote access support for JAWS without inserting 
the video driver in the display chain or restarting the server. 



 
1. Insert the JAWS program CD into the server s CD drive. If the JAWS Setup dialog 
box displays, choose the Cancel button.  
2. Press WINDOWS Key+R.  
3. Type the following (if your CD drive is not D, substitute the correct letter): 
"D:\Setup.exe" /Type Remote   

Note: If you are installing JAWS from the package for the Web, type the name and 
location of the package file enclosed in quotes. Type a space followed 
by "/a," another space, and "/remote." For example:  
"C:\j600123_ilm.exe" /Type Remote  

3. Press ENTER. When the JAWS Setup dialog box displays, choose JAWS for 
Windows Setup.  
4. When Setup asks you to select an installation type, select Custom.  
5. Press DOWN ARROW twice to select "Client."  
6. Press the SPACEBAR and then press DOWN ARROW to select "Entire feature 
will be installed on local hard drive." Press ENTER.  
7. Follow the instructions and complete the installation. For more information on 
these options, see  JAWS for Windows Setup.   

Installing Remotely  

You can install JAWS on the server from a remote location during a terminal session. 
Setup detects this type of installation and does not install JAWS drivers 
into the primary display chain, so you do not need to restart the server. Do the 
following to install JAWS from a remote computer connected to the server:  

1. Establish a remote connection between the client and server.  
2. Insert your JAWS program CD into the client computer's CD drive. If the JAWS 
Setup dialog box displays, choose the Cancel button.  
3. In the terminal session window, open the Start menu and choose My Computer.  
4. Select your local CD drive and press ENTER. When the JAWS Setup dialog box 
displays, choose the JAWS for Windows Setup button. If the dialog box does 
not appear, select the file Setup.exe and press ENTER.   

Note: If you are installing from the package for the Web, type the name and location 
of that file instead and press ENTER.   

5. When Setup asks you to select an installation type, select Custom.  
6. Press DOWN ARROW twice to select "Client."  
7. Press the SPACEBAR and then press DOWN ARROW to select "Entire feature 
will be installed on local hard drive." Press ENTER.  
8. Follow the instructions and complete the installation. For more information on 
these options, see JAWS for Windows Setup.   

If you want to uninstall JAWS on the server from a remote client computer, do not 
use the UnInstall JAWS shortcut in the JAWS program group. Instead, connect 
to the server and open the Windows Control Panel. Choose Add or Remove 
Programs and select JAWS in the list of currently installed programs. Choose the 



Change/Remove button and follow the instructions to uninstall the software.  

Enabling Remote Access Support after Installation  

You can enable (or disable) remote access client and/or server support after you 
install JAWS. To do this, choose the Advanced button in the Basic Settings 
dialog box. For more information, see Basic Settings.  

Installing JAWS on Client Computers  

After you install JAWS on the server, you must install the program on any client 
computers that will use JAWS while accessing the server remotely.  

Do the following to install the program on a client computer:  

1. Insert the JAWS program CD into the client computer s CD drive.  
2. When the JAWS Setup dialog box displays, choose the JAWS for Windows Setup 
button. If the dialog box does not appear, press WINDOWS Key+R, type 
D:\Setup.exe and press ENTER (if your CD drive is not D, substitute the correct 

letter).  
3. When Setup asks you to select an installation type, select Guided.  
4. Choose the destination folder, synthesizer components, primary speech 
synthesizer, additional Eloquence languages, and Braille components. For more 
information on these options, see JAWS for Windows Setup.  
5. When Setup asks you to select remote access components, select the Client 
Remote Access Support check box.   

Note: Setup will only install support for Citrix if the client software is installed on the 
computer. Be sure to install the Citrix client software before installing JAWS.  

6. Follow the instructions and complete the installation. If you have a single-user 
license of JAWS, you can activate your product after the installation.  

Setting Up Published Applications for Citrix  

In addition to ICA connections, you can connect to a server through a published 
application. When you open the Citrix Program Neighborhood, you see programs 
such as Word, Outlook, Notes, and so on. You can then start these programs and 
use them just as if they were installed on your local computer.   

The administrator publishes the application on the Citrix server and then sets up the 
connection through the Citrix Program Neighborhood. When setting up 
the published application on the client, you must specify your user name and 
password. On the server, the administrator must set up JAWS to run automatically 
for that user name and password. For more information, see  
Starting JAWS on the Server Automatically.  

Authorizing JAWS for Remote Access

  



When using JAWS in terminal sessions, you must have a license that includes the 
remote access option (purchased separately). After you establish a remote 
connection, the version of JAWS installed on the server attempts to obtain remote 
access authorization from the client computer. In order to obtain authorization 
from the client, the version of JAWS installed on the client computer must have either 
a stand-alone (local) license, access to a license server with one 
or more free tokens, or an attached dongle. The client computer s license must 
include the remote access option to provide authorization for the version 
of JAWS installed on the server.  

If the server cannot find the correct authorization, it searches for a license server. 
The license server must have one or more free tokens, and its multi-user 
license must include the remote access option. The server cannot obtain 
authorization from its own stand-alone (local) license or a dongle during terminal 
sessions.  

If the server cannot find any authorization, an error message appears and you will not 
be able to use JAWS during the terminal session.  

Tip: For information on activating a single-user license or setting up a license server 
for a multi-user license, refer to  
Product Activation Overview.  

Starting a Terminal Session

  

After you have installed JAWS on the server and client computers and activated your 
license, you can begin using JAWS in terminal sessions. To start a terminal 
session, do the following:   

1. Start the client software you are using to connect to the server (such as Program 
Neighborhood or Remote Desktop).   

Tip: Remote Desktop is included with Windows XP and is also available for Windows 
2000. To start this program, open the Start menu and choose Programs, 
Accessories, Communications, Remote Desktop Connection.  

2. Establish a connection to the server. For information on connections, refer to your 
client software documentation.  
3. Log on to the server using the credentials supplied by the system administrator. If 
you want to save your credentials so you do not need to enter them each time you 
connect, see Saving Your Logon Information.  
4. In the terminal session window, start JAWS on the server. You will not hear any 
speech or receive braille feedback until you start JAWS on the server. 
If you want JAWS to start automatically after you connect to the server, see  
Starting JAWS on the Server Automatically.   

Tip: You can start JAWS quickly by pressing WINDOWS Key+R and typing JAWS 
followed by the version number. For example, to start JAWS 7.0, you would type 
JAWS7 and press ENTER.  



Tip: For a list of keystrokes for performing standard Windows functions while in a 
terminal session, see Keystrokes for Citrix and Terminal Services.  

Saving Your Logon Information  

JAWS does not start on the server during terminal sessions until you log on. 
Therefore, it is recommended that you save your user name and password so you 
do not need to enter this information when connecting to the server.  

Citrix Program Neighborhood  

To save your user credentials for a connection in Citrix Program Neighborhood, do 
the following:  

1. Start Citrix Program Neighborhood and select your connection.  
2. Press the APPLICATION Key and choose Properties.  
3. Hold down CTRL and press the TAB key until you move to the Login Information 
tab.  
4. Enter your user name and password.  
5. Choose OK.   

Terminal Services Client and Remote Desktop   

To save your user credentials for a connection in Terminal Services Client or Remote 
Desktop, do the following:  

1. Start Terminal Services Client or Remote Desktop.  
2. In the Computer combo box, select the IP address of the remote computer.  
3. Choose the Options button.  
4. On the General tab, enter your user name and password.  
5. Press ALT+A to select the Save My Password check box.  
6. Choose Save As to save this connection.   

Starting JAWS on the Server Automatically   

If you want JAWS to start automatically when you log in so you receive speech 
and/or Braille feedback immediately, do the following:  

1. Start a terminal session and log on to the server.  
2. Select the JAWS shortcut on the terminal session desktop and press ENTER.  
3. From the Options menu, choose Basics.  
4. Move to the Automatically Start JAWS check box and press the SPACEBAR.  
5. Choose OK to add the JAWS shortcut to the Startup folder for your user account.   

If you have local access to the server computer, you can add the JAWS shortcut to 
the Startup folder manually. This provides speech feedback the first time 
you log on to the server. Do the following to add the shortcut:  

1. Log on to the computer with the account you use for remote connections.  
2. On the Windows desktop, select the JAWS shortcut and press CTRL+C.  



3. Press WINDOWS Key+E to start Windows Explorer.  
4. Navigate to the folder C:\Documents and Settings\User Name\Start 
Menu\Programs\Startup.  
5. Press CTRL+V to paste the shortcut into the folder  

Ending a Terminal Session

  
When you have finished working in a terminal session, you can choose to either 
disconnect or log off from the server. If you disconnect, you end the connection 
between the client and server computers, but your user account remains logged on. 
Depending on how the administrator sets up the server, this may cause 
your programs and files to remain open and use system resources. Logging off from 
the server ends the connection and closes all your programs and files, 
ensuring that they do not consume unnecessary server resources.  

Troubleshooting JAWS Remote Access

  

Using Your Computer as a Remote Access Server and Client  

If you install both the client and server remote access components, you can use your 
computer as both a client and server for terminal sessions. This means, 
for example, that you can use your computer at work in terminal sessions and then 
go home and connect remotely to your work computer.   

If you are going to connect to a computer remotely, it is recommended that you add 
the JAWS shortcut to the computer's Startup folder in the Start menu. 
When you log into your account during a remote terminal session with this computer, 
JAWS starts automatically. For detailed steps for adding JAWS to your Startup folder, 
see Starting a Terminal Session.  

If you want to connect remotely to a computer that you use locally with JAWS, it is 
recommended that you quit JAWS and log off the local computer before 
attempting to connect to it remotely.   

Tip: To log off, open the Start menu and choose Log Off. If this command is not 
available, press WINDOWS Key+R, type "logoff" and press ENTER.  

If you did not log off or quit JAWS before connecting remotely to the computer, do the 
following:  

1. Start a terminal session , connect to the remote computer, and log on.  
2. Start JAWS if necessary and press INSERT+J to go to the JAWS window.  
3. From the Language menu, select Change Synthesizer and press RIGHT ARROW.  
4. Choose Remote Access Speech.  
5. If you are using a Braille display, open the Options menu and choose Braille.  
6. In the Default Braille Display list, choose "Remote Access Braille" and  
press ENTER.   

Before ending your terminal session, change the speech synthesizer and Braille 
display back to the settings you normally use. This ensures that speech and 



Braille function correctly when you return to use the computer locally.  

Understanding the JAWS Virtual Channel  

The virtual channel is set up automatically when you install JAWS with client remote 
access components. The virtual channel sends output information that 
results from a user s actions in the terminal session from the version of JAWS 
running on the server to the local version of JAWS installed on the client 
computer. The local version of JAWS then relays this information to the user through 
a software synthesizer (such as Eloquence), hardware synthesizer, 
and/or braille display during terminal sessions.  

The virtual channel decreases the load on the server, since the client computer does 
the work of translating the output into information the user can understand.  

Video Intercept Issues  

When you install the remote access components, Setup installs all the required video 
intercept drivers in the display chain. JAWS uses these drivers to 
read screen information in terminal sessions. When you are connected remotely to a 
server, the Fsvidrdp (for RDP) or Fsvidica (for ICA) driver must be 
installed in the Microsoft RDP or Citrix ICA display chain. However, you cannot use 
the server locally with JAWS unless JAWSVID is installed in the Primary 
display chain. When you install JAWS on the server from within a terminal session, or 
if you use the /remote command line switch, JAWSVID is not installed in the Primary 
display chain.   

You can use Display Chaining Manager (DCM) to change the order of these drivers 
or remove drivers from the display chain. To start Display Chaining Manager, 
open the Start menu and go to the JAWS program group. Open the Tools menu and 
choose Display Chaining Manager. For more information, refer to  
Display Chaining Manager.   

Modifications to the Client System  

When installing JAWS with remote access components on the client system, the 
following modifications are made:   

Microsoft Terminal Services Modifications   

Fsmvd.dll is installed in the JAWS program folder.   
The value Name in the registry key My 

Computer\HKEY_CURRENT_USER\Software\Microsoft\ Terminal Server Client is 
set to Fsmvd.dll, located in the folder where you installed JAWS.   

Note: Because this is a current user setting, certain issues may occur if you install 
JAWS using one account and then run JAWS using a different account. 
If any problems occur, add this key to the registry for your user account.   

Citrix Program Neighborhood Modifications 



  
Fscvd.dll is installed in the Citrix\ICA Client folder.   
The following entries are added to the Modules.ini file in the Citrix\ICA Client folder:    

The [ICA 3.0]\VirtualDriver key has JAWS in the comma delimited list of drivers.   
[VirtualDriver]\JAWS=   

Note: There is no value to the right of the equal sign for this entry. This is by design.    

[JAWS]\DriverName=Unsupported   
[JAWS]\DriverNameWin16=Unsupported   
[JAWS]\DriverNameWin32=jawscvd.dll   

Modifications to the Server System  

When installing JAWS on the server system the following modifications are made:   

Microsoft Terminal Services Modifications   

Fsvidrdp.dll is installed to the Windows or WinNT\System32 folder.   
Fsvidrdp.dll is added to the video chain for Microsoft RDP. See  

Display Chaining Manager for more information.   
The Hjsmem folder is created in Windows or WinNT\System32 folder with full user 

rights (creation/read/write/execute).   

Citrix MetaFrame Modifications   

Fsvidica.dll is installed to the Windows or WinNT\System32 folder.   
Fsvidica.dll is added to the video chain for Citrix ICA. See  

Display Chaining Manager for more information.   

Note: Setup only adds this driver if Citrix MetaFrame is installed on the server. If it is 
not installed, the Citrix ICA driver will not be listed in the Display Chaining Manager 
dialog box.    

The Hjsmem folder is created in the Windows or WinNT\System32 folder with full 
user rights (creation/read/write/execute).   

Keystrokes for Citrix and Terminal Services

  

Because terminal session environments display a virtual desktop within a window on 
your computer, some commands that you often use in Windows will have 
no affect on the programs and windows in the Terminal Services environment. For 
example, if you press the WINDOWS Key while working in the terminal services 
environment, it opens the client computer s Start menu, not the Start menu in the 
terminal services window.  

This section provides a list of the default Windows keystrokes that work in the Citrix 
and Terminal Services environments.  



Citrix Keystrokes for Windows Commands 
Tabell med 2 kolumner och 7 rader   

Windows Command   Keystroke  

Close the terminal session window  SHIFT+F3  

Open the Windows Security  
dialog box (CTRL+ALT+DEL)  CTRL+F1  

Open Start Menu (CTRL+ESC  
or WINDOWS Key)    CTRL+F2  

Starts the Windows Task Manager  
(CTRL+SHIFT+ESC)    CTRL+F3  

Switch to the next/previous window 
(ALT+TAB and ALT+SHIFT+TAB)   ALT+PLUS SIGN and  

ALT+MINUS SIGN  

Cycle through items in the order they  
were opened (ALT+ESC)   ALT+F2    

Using Standard Windows Keystrokes  

By default, Citrix starts your terminal sessions in a window. If you begin your terminal 
sessions in full screen mode instead, you can use the standard 
keystrokes for Windows commands rather than the special Citrix keystrokes listed 
previously.   

To configure your custom ICA connections or an application set to open in full screen 
mode, do the following:  

1. Start Citrix Program Neighborhood. You should see either your custom ICA 
connections or default application set. If you do not see either of these, select 
either the Custom ICA Connections icon or the icon for the application set and press 
ENTER.  
2. From the File menu, choose Custom Connections Settings or Application Set 
Settings.  
3. Press CTRL+TAB to move to the Default Options tab.  
4. In the Window Size combo box, select "Full Screen."  
5. Choose the OK button.   

You can also specify that you want to use full screen mode when you create a new 
custom ICA connection or application. Follow the instructions provided 
to create the connection or application set, and be sure to select "Full Screen" in the 
Window Size combo box.  



Terminal Services Keystrokes for Windows Commands  

Note: If you are using full screen mode, then you can use the standard Windows 
keystrokes for these commands. To switch between full screen and window mode, 
press ALT+CTRL+BREAK.     

Windows Command   Keystroke   

Open the Windows Security  
dialog box (CTRL+ALT+DEL)   ALT+CTRL+END  

Open program s control menu 
(ALT+SPACEBAR)    ALT+DELETE  

Open Start menu (CTRL+ESC  
or WINDOWS Key)    ALT+HOME  

Switch to the next/previous window 
(ALT+TAB and ALT+SHIFT+TAB)   ALT+PAGE UP and  

ALT+PAGE DOWN  

Cycle through items in the order  
they were opened (ALT+ESC)   ALT+INSERT  

Take a snapshot of the terminal  
session window (Print Scrn)   ALT+CTRL+NUM PAD PLUS  

Take a snapshot of the active window  
in the terminal session (ALT+Print Scrn)  ALT+CTRL+NUM PAD MINUS     


